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Introduction
If you have wanted to get into the coloring book game but just never 
knew how, or you simply want to take things to the next level, then 
this is the course that will teach you exactly that.

You will learn how to quickly and easily create high quality coloring 
books using free resources. This will allow you to scale up your 
business and increase your profits.

The examples in this pdf use Photoshop to show you the exact step by 
step process used to create the line art for your coloring books. I will 
also show you how to do it with Gimp, which is a free software 
available for both Windows and Mac.

Once you have gone through the process two or three times, it should 
only take you about thirty seconds to create each line art image. So in 
theory, you could create an entire coloring book in less than an hour.

Let’s get started…



Finding Your Free Images

The best place to find an almost unlimited amount of images for your 
coloring books is pixabay.com in my opinion. It lets you filter and 
search for png images with transparent backgrounds (which we need) 
and it’s completely free to use!

While there are a couple other royalty free image sites out there, 
pixabay is probably the one with the best selection of images out 
there.

Sign up for free to get started.

After you are done signing up, you can start looking for images related
to the type of coloring book you want to create.

As long as they have transparent backgrounds, you are good to go. 

So let’s search for some example images to use to show you the 
process.

https://pixabay.com/
https://pixabay.com/


In this case, I chose “fruit” as my example. I don’t really recommend 
creating a coloring book featuring different fruit…but hey, there might
be a market for that.

Next up, you need to filter the results to show images with transparent 
backgrounds only. Then just download the images you like for your 
coloring book  



Creating Line Art in Photoshop

First up, I will show you how to create amazing line art images from 
the ones you chose to download on Pixabay.

I will go over how to do it on Photoshop first, followed by how to use 
the free image editor, Gimp, to achieve the same result.

Let’s go ahead and open an image.

First of all, we need to make this a black and white image, so head 
over to Image>Adjustments>Desaturate

You will get a greyscale image that you can further edit.

Now you need to duplicate that layer in Photoshop.

Right click the layer on the right hand side and hit “Duplicate Layer”



Next, invert the copy of the layer you just created by going to 
Image>Adjustments>Invert

In the “Layers” tab, where it says “Normal” click on the little 
dropdown menu and select “Color Dodge”



Don’t worry. Your image will change to white until you complete the 
final step, which is applying a Gaussian Blur filter.

With the copy of the main layer still selected click on 
Filter>Blur>Gaussian Blur

The end result is something that will look like this:



A perfectly colorable line art image, ready to be used for a coloring 
book!

As you can see, with only five steps, you can create amazing line art 
from any image with a transparent background.

For those of you who don’t have Photoshop, there is always the option
to use Gimp, or another free software of your choosing. I personally 
chose Gimp though because of its similarities to Photoshop.

Let’s take a look.



Creating Line Art in GIMP

First of all, if you don’t have Gimp yet, head over to their website and 
download the latest version. 

Click Here To Download It For Free

Once you are done downloading and installing GIMP, open up one of 
the images. I will continue to use the bananas in this case  

Next up, head to Colors>Desaturate>Desaturate 

https://www.gimp.org/


Just like in Photoshop, duplicate the desaturated layer. 
To do that, simply right click and hit “duplicate”

From now on, make sure you select the duplicated layer when 
performing new actions.

With the newly created layer selected, go to Colors>Invert 



The process is exactly the same as with Photoshop, just the menus are 
a bit different.

Again, where it says “Mode: Normal” click on the dropdown menu 
and select “Dodge”.

Your image will turn white. No need to panic.



In this last step, we will apply the Gaussian filter and we will be good 
to go…

Click on Filters>Blur>Gaussian Blur

You can play around with the sliders until you are satisfied with the 
result of course.

Let’s take a look at the final result…



Another nice line art image, ready to be used for a coloring book! 

As you can see, GIMP is basically just as easy to use as Photoshop 
and its free  



Adding Colorable Text

Having an awesome looking coloring book created in less than an 
hour is kinda cool… but how about we make it a little bit cooler?

I’m going to show you how to add perfectly colorable text to the line 
art images so you can have more options designing your books. 

Using GIMP, follow my lead as I add some awesome text to our 
example image!

First of all, you will have to download a font that stands out and is just
cool to color in. I chose “Triump Rg Rock” for this.

Click Here To Download It

https://s3.amazonaws.com/andreasquintana/triumprgrock06.otf


After you install the font, you are good to go. Type in a word or 
phrase you would like to edit. It might look like it’s done, but we need
to create an outline for it, or the text won’t be visible when printed.

Select the text, then right click and hit “Path from Text”.



Then go to Layer>New Layer

Name it “Text Outline” and hit OK.



Now click on Select>From Path.

Your text will become automatically highlighted.



Go to Select>Grow, and make sure to select anywhere from 2 to 4 
pixels, depending on your font size. You might want to experiment 
with that.

Now select the bucket tool and click on the text. It should look like 
this:



All that’s left to do now is hit Select>None

Finally, you can just move the recently created outline layer 
underneath the actual text layer.



Your final result will look like this:

That’s it! You now know how to create perfect line art images for 
your coloring books and how to add awesome looking colorable text 
to it.



Assembling Your Coloring Books

This part of the publishing process used to scare my socks off. It was 
intimidating to me, because I thought there would be some magic 
component to it that I could never figure out on my own. 

You only need to use a word processor software of your choosing. I 
use Libre Office. I used to use Open Office. Both are free. Microsoft 
Word is another popular option. 

Andreas has a Mac. He uses Microsoft Word for Mac and Pages for 
Mac computers.

There is no need to complicate this at all. Use the word processor 
you like using.

Amazon provides a complete manual for formatting your books. You 
can find that here:
https://kdp.amazon.com/en_US/help/topic/G202145400

Give the manual a quick once-over to understand the basic principles.

Once you have done that, here is my simple rule of thumb on 
every print book I publish:

 Choose 8.5x11, 8x10 or 6x9 for my page size.
 Set margins to “Mirror Margins” with a depth of 0.375” for the 

gutter. This setting works for any book up to 150 pages. 
 If my book is between 150 and 300 pages, which is rare, then I 

set “Mirrored Margins” with a depth of 0.5” for the gutter.
 No matter how many pages your book has, you should have 

outside margins at least 0.25” with no bleed and 0.375” with 
bleed. I always just set mine to 0.375” so I know it is always 
right.

 You want a title page and a copyright page, before any content 
in your book.

https://kdp.amazon.com/en_US/help/topic/G202145400


 I do not put the ISBN on the copyright page, because Amazon 
puts it on the outside of the book for us, with the barcode.

 The title of your book must match in three places: on the title 
page, the book cover, and in the book listing on Amazon.

 You do not need to include the sub-title, if you use one, inside 
your book or on the book cover.

 You should include a blank page on the reverse side of your 
coloring book illustrations.

 You don’t usually want to include page numbers on the same 
page as your illustration. I just don’t use page numbers at all in 
my coloring books.

 I always try to include an About The Author page, before the 
end of my book. This page includes a URL the user can follow 
to find more of my books.

 If you set up a free Author Central account, Amazon will give 
you a central page on their website to highlight your marketing 
and your books.

 I typically purchase a domain name that I redirect to my Author 
Central account, to give myself the ability to have a simple URL 
for my author profile.

 Inside my About The Author page, I include the domain name 
that redirects to my Author Central account page on Amazon. 

If you get stumped by any of this, you can ask additional questions 
and watch additional training videos produced by Bill Platt, inside of 
his free Facebook group for coloring book authors:
https://www.facebook.com/groups/ColoringBooksAdults/

If Bill is not around, there are almost 3,000 people in the group, who 
may also have the proper experience to answer your questions 
accurately.

https://www.facebook.com/groups/ColoringBooksAdults/
https://authorcentral.amazon.com/


Who & Why People Buy Coloring Books

It is important that you understand that Andreas has simply laid out 
for you the basics of: 

 How to convert simple illustrations into coloring book art; and
 How to make text part of the coloring experience for consumers.

Now that you understand the HOW, you will want to figure out WHO 
is going to want to buy your coloring books, and what kinds of 
designs those folks will want to color. 

If we are doing coloring books for children, simple is fine. The design 
shown in the example – the bunch of bananas – may be the perfect 
coloring design to present to young children. Children do not need or 
want a lot of detail in the images they will want to color. 

Older children may want a little more detail to make the coloring 
designs a little more challenging for them. 

Adults purchase coloring books for a variety of different reasons.

When you understand WHY adults buy coloring books and WHAT 
kinds of coloring books they want to buy, you will be better prepared 
to:

1. Give consumers the kinds of illustrations they want to color; 
and

2. Explain to them why they would want to buy your coloring 
books.

One of my favorite books on selling is called “Unlimited Selling 
Power: How to Master Hypnotic Selling Skills.”

You might be wondering what this has to do with selling coloring 
books, and I am going to tell you about that here in just a minute. 

https://amzn.to/2CsiX8P
https://amzn.to/2CsiX8P


Please bear with me, because I think this is important to our goal of 
creating coloring books people will want to buy.

The authors of “Unlimited Selling Power” approached their book on 
the pretext that they wanted to understand what made the most 
successful sales people so effective at selling.

What the authors came away with was absolutely fascinating.

It had been observed for years that it rarely works out to take a 
company’s best sales people and promote them to sales management. 
Most of those folks are very talented sales people. They understand 
how to sell, but they don’t understand the sales process at a level 
where they could teach others how to do the same.

So the authors of the book set up hidden cameras to watch the sales 
people work with customers, to better understand the dynamics of the 
selling process.

After years of study and teaching other sales people how to be more 
effective in their profession, the authors put together their book to 
teach people like us how we could do the same.

I read that book again and again, until the pages started falling out, 
then I ordered another copy of the book.

So, one of the things they discovered is that the best sales people tend 
to ask people one particular kind of question, then they listen intently 
to the answers.

What are the 5 most important things you want to find in an X?

X doesn’t matter. This works no matter what type of purchase is to be 
made. X could be a car, a house, a boat, or even a coloring book.

There is actually a magic in this question structure. 



Suppose someone was buying a car. “If you were to find the perfect 
car today, what are the things that you would consider most important
in your buying decision today?”

The good sales person will make a mental note of the most important 
things indicated by the consumer as something that would influence 
the customer’s buying decision, and the sales person would also take 
notice of the order in which those things were described. 

Why? 

Here is WHY there is magic in the questions, and more so in the 
answers given. 

When we are asked what is most important to us, when we are 
considering a purchase, we will in fact tell the sales person exactly 
what we think is important, and we will share with them the details in 
order of importance.

In other words, the answer we give to the question will always be 
structured in this way:

1. Most important thing;
2. Second most important thing;
3. Third most important thing;
4. Fourth most important thing;
5. Fifth most important thing. :)

The last time I went to buy a vehicle, these are what my five most 
important considerations were:

1. Pickup truck;
2. Seats four comfortably;
3. Good operating condition;
4. Power windows, power seats;
5. Hopefully a sunroof.



Would you be surprised to learn that the vehicle I purchased met all 
five criteria?

It was really interesting that the book author said that even if you 
understand what is going during the process, we simply cannot resist 
the sales person who uses this approach in the sales process.

He said that he was shopping for a house for his family, and his real 
estate lady asked him what the most important things were that he was
looking for in a new home. 

He said he answered the question, then when she showed him a house,
she spoke of the reasons why he would want to own the house, given 
back to him in the same order that he told her.

He said, when he made the purchase, he had to give up some of the 
things on his “want list”. His real estate lady understood that, so she 
kept an eye out for other homes that might be a better fit for him, even
if he had already purchased a house from her. He said that she ended 
up selling him on two more “upgrade homes” over the next few years, 
because she always knew exactly what he wanted in a house and how 
she could get him closer to his goals. 

This is precisely how you can determine what people want in the 
coloring books they buy… 

Find someone who likes to buy a lot of coloring books, then ask them 
that all-important question…

When you are looking to buy a new coloring books, what are the
five most important considerations you look for in the books you
buy?

You already know why you want to ask the question. 

The most important bit is the answer to the question. Take notes. 



You want to understand the five most important considerations 
consumers have, and you want to understand their reasons in order of 
importance.

Once you understand the five most important things, in order of 
importance, then you can address those items in your book 
description, giving weight to the most important things and in the 
order of importance. 



How Real People Answer This Question

Before we jump into the actual data, we should first discuss the law of 
averages.

If you were to ask any number of people who like buying coloring 
books what the five most important things are when they are 
considering a purchase, you may hear up to 15 to 20 potential 
answers.

Truthfully, no matter the question, if you ask enough people, you will 
find on average 15 to 20 possible answers.

Those 15 to 20 possible answers can actually be reorganized in 
hundreds of different orders. 

At a certain point, if you ask enough people, you will come to 
understand why different types of consumers make the purchases that 
they do. There is power in that knowledge, because it will help you 
better understand how to describe your coloring books in a way that 
encourages more people to make the purchase decision in favor of 
your books.

Here are some of the reasons I discovered about why adults 
purchase coloring books:

 Helps them to pass the time;
 It is fun to do;
 It helps them explore the relationship between colors and 

contrast in designs;
 It provides an opportunity to try new things and improve their 

skills as an artist, by letting them explore new ways to use colors
and different kinds of drawing utensils (pens, pencils, markers, 
etc.) in their own artwork;

 It gives them the ability to feel good about themselves and the 
beauty they are able to create;

 It allows the “colorist” – the person coloring the pages – to 
demonstrate to friends and family their artistic skills;



 It is an inexpensive way to decorate the walls in their home;
 Coloring book artwork lets people do something creative to 

make wall art décor for inexpensive Christmas gifts (I know this 
to be true, because I have some on my wall colored by other 
people);

 It provides the “colorist” the opportunity to receive praise from 
others, which helps boost their ego and self-esteem;

 It allows them to have bragging rights when showing off their 
creative talents to others. 

The group of buying reasons I described above are what I refer to as 
the “ego-driven colorists”. They buy coloring books and color the 
pictures to help strengthen their ego and self-esteem.

Now don’t get me wrong. Some people do it just because it is fun. But
a lot of people are driven strongly by the need to receive praise for 
what they have done.

There is also another set of people who purchase coloring books, who 
have different reasons for why they buy certain coloring books.

This next group is what I refer to as the “therapy-seeking 
colorists.”

Some have taken up coloring, because their therapists have made that 
recommendation. Some have friends or family, who have suggested 
that coloring books might help them deal with their issues. 

A few years ago, psychiatrists, psychologists, counselers and 
therapists started prescribing people to use coloring books to help with
mental health issues. There appears to be healing value in keeping the 
mind active and sharp, while focusing on the intricate details inside of 
the coloring designs.

There are actually two sub-sets of people in this group:

1. Those needing to calm and clear their minds;



2. Those needing to keep their minds sharp.
The first sub-set is made up of people who are fidgity, are distracted, 
and cannot keep themselves calm. This group is often represented by 
people with ADHD, ADD, Asperger’s Syndrome, panic attacks, 
anxiety, OCD and PTSD, just to name a few.

The second sub-set of people are those suffering from old-age related 
mental health issues, such as dementia, depression, anxiety, cognitive 
issues, and even Alzheimer’s disease. This set of people are often 
facing a decline in functional ability, which includes deterioration in 
memory, thinking, behaviour and the ability to perform everyday 
activities.

Coloring books tend to offer a certain level of preventative therapy to 
slow the decline in older people, and it also helps some people regain 
and strengthen cognitive abilities, to help them improve the quality of 
their lives.

Those people who use coloring books to boost their ego and self-
esteem will not be motivated to make a purchase by reading about the 
therapeutic advantages of coloring.

Those who turn to coloring books to treat mental health issues will not
be motivated to purchase based on ego-driven thinking.
 



Focus on a Sub-Set of Buyers

In the previous chapter, I set forward many of the reasons why adults 
buy coloring books.

When you are describing your book to a potential buyer, you should 
never try to appeal to several types of customers at the same time. 

It is important to understand that we cannot “please all of the 
people, all of the time.”

For example…

My training materials do not appeal to everyone on the planet. If I 
tried to sell my stuff to everyone, I’d only occasionally find one or 
two buyers and I would waste a whole lot of time and money 
advertising to the wrong people.

My training materials are actually for people who want to learn how to
produce different kinds of books and sell them to the largest number 
of people possible. 

So my audience is not everyone. Instead, it is people who want to 
learn about publishing certain types of books. 

But, here is an important consideration also. My training is not for 
anyone who wants to publish books. My training is more specifically 
geared to future and current self-published authors, who want to learn 
how to self-publish and sell books. 

This is an important distinction to make, because the people who think
they are going to find an agent or find a traditional publisher to 
publish their books are not going to be interested in my training 
materials. 

To put this into perspective, one of my ghost writers is a very talented 
fiction author. She has self-published two novels, but she has no 
intention of self-publishing a third novel, because she believes that she



will find a traditional publisher to do all of those things she doesn’t 
want to do, like designing a book cover or marketing her books.

In her case, I cannot tell her that I will teach her how to market her 
own books. I just have to wish her well in her endeavors. I cannot 
force her to want to learn those things she doesn’t want to learn.

It is funny to listen to her talk about her search. “Funny” in a not-so-
funny way, but “funny” in the respect that I am not surprised at the 
outcome of what she is seeing happen.

She has been working for me for four years. I hired her right after she 
published her first book, and when she was nearly finished with her 
second book. About two years ago, she published her second novel.

Now she had two novels sitting on Amazon collecting virtual dust, 
because she had only sold a few dozen copies of each book.

It was at this point that she decided that she didn’t know what she was
doing on the marketing side, and she decided that she would hire an 
agent to help her find a traditional publisher.

I remember telling her at the time that the marketing isn’t as difficult 
as she thinks it is, and if she would just do a few things, she would be 
light-years ahead of her competition. 

I gave her some simple advice on how to find an audience for her 
books – advice that she never implemented.

She didn’t implement the advice I gave her, because she had already 
decided to go the route of traditional publishing. 

I happened to be talking to her again just last week, and she told me 
that she was extraordinarily disappointed with her search to find an 
agent and a traditional publisher to publish her books. 



At this point, it seems that she has presented her latest novel to 200 
agents and a few dozen publishers, and to date, she has yet to find 
anyone to show any interest at all in her work. 

“Ah… That is a real shame,” I told her.

Between you and me, I knew in advance that she was going to have a 
difficult journey ahead. I told her as much two years ago, but I am not 
going to rub it in by reminding her that I told her so.

My point is that what I teach to self-published authors does not 
appeal to people who want to be traditionally-published.

So, I would be a fool to try to advertise my training guides to people 
who want to be traditionally-published authors. They are not 
interested, and they will not be buying my training guides. 

The bottom line is that I need to focus my product / book descriptions 
on people who are looking to learn about self-publishing their books. 
To do otherwise would be unproductive and it might just suck all of 
the wind from my sails. 

We need to figure out WHO we are going to target in our book 
descriptions, and we need to FOCUS on giving them exactly what 
they need to hear to decide in favor of purchasing our books.

The problem is that when we try to appeal to both in our book 
description, people will tell themselves things like:

 “Well, this coloring book looks like it might help me deal with 
my anxiety, but since the author is also talking about hanging 
the artwork on my wall, I am not sure this book is exactly what I 
need to buy today.”

 “This coloring book looks like it would be a lot of fun to color, 
but the author is talking about using it to keep my mind sharp, 
so I am not sure that it will be as much fun as the author 
claimed.”



Anytime we write a book description that makes our book seem more 
inclusive to a larger audience, we are actually damaging our future 
sales, because we are also giving people “reasons not to buy” our 
books.

In my first example, “dealing with anxiety” is the reason to buy, but 
the “creating wall art” convinces the reader that this book isn’t 
exactly what he or she wants to buy.

In the second example, “fun” is the reason why they might want to 
buy, and “keeping your mind sharp” is a distraction from having fun 
and convinces the consumer that this book isn’t directly focused on 
“giving the buyer a good time”.

Are you starting to understand why FOCUS is so important in the
process of writing an effective book description?

Quite simply, people want to buy the EXACT BOOK they want to 
buy. They don’t want something that is just similar or close to what 
they want. They want to buy something that is very specific to their 
personal wants and desires.

The closer you can get to describing EXACTLY WHAT THEY 
WANT to buy, when you are describing your book to a potential 
customer, the more likely you will be to get another sale.



Focus on the Benefit

In the previous three chapters, I addressed:

 WHY people buy coloring books; 
 WHAT reasons people give for buying;
 WHO is most interested in making a purchase.

In this chapter, I want to talk in a little more depth about HOW to tell 
the story of your book to people who might want to buy it.

I will be honest. This is a concept that took me a long time to 
understand. 

People don’t buy things based on what a product has. Instead, people 
buy things based on how those things can impact their lives.

For example…

People don’t buy cars because the car has good gas mileage. They buy
the car because it will cost less to operate. :) Yes, it is basically the 
same thing, but it is not enough to point to the gas mileage. We need 
to demonstrate to people what benefit can be derived from the feature. 

Another example, more directly related to our coloring books is this…

People don’t buy our coloring books because the reverse side of an 
image page is blank. That is a feature of our book. Instead, people buy
our book because the blank page on the reverse side of the page 
prevents the coloring ink from bleeding through to the next design.

People also don’t buy our coloring books because they have 50 unique
designs in them. Instead, they buy our coloring books, because they 
will keep our customers entertained for weeks or months.

People don’t buy our coloring books because they have extremely 
detailed designs. Instead, they buy our coloring books because our 



extremely detailed designs will help them keep their minds sharp and 
focused on important details.

People don’t buy our coloring books because they make beautiful 
black-and-white images. Instead, people buy our coloring books, 
because our designs are such that when they have finished coloring 
them, they will want to hang them on the wall and share them with 
friends and family. “Can you imagine how many people will be 
talking about your artwork, when people come to visit?”

Are you starting to see the common thread here? 

It is not what is within the product that makes the difference in sales. 
Instead it is how the consumer will be impacted – how they will feel – 
during and after coloring the illustrations in our books. It is all about 
customer-experience.

Think about how you could describe your coloring book to 
potential buyers, and consider how you can frame the experience 
of using your coloring books.

Features describe what is inside the product. 

Benefits describe the customer experience of using your product. 

Consider this approach to writing a good coloring book 
description…

Inside of this coloring book, you will find 50 incredible 
illustrations containing lots of detail – details which will really 
allow you to explore your creative talents and to try new things.

You will experience hours of pleasure and joy as you decide 
which colors would bring out the most beauty in each design. 

As you finish coloring each design, you might even find yourself 
contemplating which frame would best highlight your colored 
image, so that you can hang it on your wall.



You may even find that you have so many beautiful coloring 
pages that you are not sure which ones to hang in your own 
house, and which ones to frame as gifts to give away this 
Christmas season.

Imagine the joy that others will feel when they are able to enjoy 
your creative talents year around and every time they notice 
your artwork hanging on the wall. 

With luck on your side, the kids and grandkids may even 
discover inspiration in the talent you were able to demonstrate 
through the coloring art you will be able to share with them.

50 images. Extremely detailed. Hours of enjoyment. Ego, ego, ego.

We talk about the product, then we talk about the experience of using 
the product. We think about how our customers might FEEL about 
using our books, then we discuss the FEELINGS they may experience
as a result of using our books.

The features give them some guidance on what they should expect 
inside the book. 

The thing that sell the book is the actual experience of using the book 
– of sharing with others the final artwork.

You and I both know that our customers don’t bring any real talent to 
the coloring project. They are using our coloring books, because they 
probably cannot draw as well as we can. 

However, once they apply the colored pens or pencils to the artwork, 
they will take personal ownership of the final design.

They don’t view the artwork as “something they colored.” Instead, 
they view the final artwork as “something they created.”



We have to be willing to give them that, to allow them the opportunity
to feel as if they actual brought real talent to the project, so that they 
can take away from it a feeling of jubilation over what they 
accomplished – the pure joy of creating something of value to others.
The more effective we are at painting a picture of their emotions, as a 
result of using our coloring books, the more copies of our books that 
we will sell. 

If you have friends that enjoy coloring books, ask them what they look
for in the books they buy and the five most important things that will 
help them make the decision to buy. Take mental notes, and write 
them down later. 

Prior to publishing your coloring book, sit down with a piece of paper 
and draw a line down the middle of the page. 

On the left-hand side of the page, write down the FEATURES of your 
book. Remember, features are descriptions of what your book 
contains. Try to write down everything you can think of. 

For example:

 Number of illustrations;
 Theme of illustrations inside the book;
 Is there a consistent theme behind the illustrations (all birds, all 

dogs, etc.);
 Thickness of lines;
 Darkness of lines;
 Amount of detail in images;
 Whether pages have borders or not;
 Whether designs are a known item or random design;
 Blank page on reverse side of page (recommended);
 Large coloring areas or small coloring areas;
 White or Cream-colored pages (I recommend white);
 Anything else that I might not have suggested.



On the right hand side of the page, write down the kind of experiences
users might have as a result of coloring the illustrations in your 
coloring book.

Once you have completed the brainstorming phase, sit down and be 
very focused on writing a book description that delivers feature-
benefit, feature-benefit, for several paragraphs.
Do your best to tell people what they should find within your book, 
but make an extra special effort to describe to people the experience of
coloring the illustrations within your book.

Pick a direction. Focus on fun, focus on ego or focus on therapy, when
you are demonstrating benefits to potential buyers. Don’t try to appeal
to all three audiences. Pick one and deliver the story of your book on 
the basis of the audience to whom you are trying to attract to 
purchasing your coloring book.

You will likely find, as I have found over years of experience, that the 
better you can qualify your buyers, the better your overall sales will be
for your coloring books. 

Chance and luck play no role in a successful book launch. They 
simply don’t. 

If you don’t have good book descriptions, people won’t buy your 
books.

Even with plenty of social proof in the form of multiple, positive book
reviews, sales can and will be impacted by whether a book has a 
compelling description or not.

COMPELLING is a really simple word that packs a lot of punch. It 
simply means that you have created the kind of book description that 
touches people emotionally and fires them up to make a purchase. 

Fortunately, our book descriptions are never set in stone. We can 
change them as often as we want, with no problems or restriction. 



With some of my books, I have been known to continue tweaking my 
book description years after launch, with dozens of incarnations, all in 
an effort to improve my overall sales on that particular title. 

There is nothing wrong with trying to incrementally squeeze more 
sales out of a particular book. 

The only thing I would like to say in addition is that we should try to 
do some level of split-testing, to measure the success of one book 
description against another, so that our sales percentages are always 
going up and not down. 

The best way I have found is to keep a written record of all of my 
book descriptions, and to measure sales on a daily and weekly 
average. 

On longer cycles, the weekly average is the most honest, because 
Tuesday sales always dwarf Sunday sales. :)



Talk to the Right Audience

The beauty of this approach as far as demonstrating your coloring
books to future customers is that the more you know about your 
customers, the more capable you will be when you go out and try 
to advertise your books.

If you figure out that the people buying more of your coloring books 
are the ego-driven buyers, then you might also determine that most of 
those customers are women over the age of fourty. It is what it is. 

If you want to better understand the ego-driven buyers, the women 
over fourty, who buy a lot of coloring books, join a few Facebook 
groups for “colorists” and pay close attention to how people share 
their images and how they brag about what they have accomplished.

These are people that have all of their insecurities on full-broadcast 
mode, with the highest volume level they can muster. 

“Look at me. Look at me. Look at how awesome I am and how 
talented I am. Praise me.”

I honestly don’t think I am exaggerating this much, if at all. :)

Paying attention to these things is important, because the better we can
tune into their mindset and what they do online, the more capable we 
will be when describing our coloring books in a way that will appeal 
to them, but also where we can advertise our books online to get their 
attention.

On the flipside, I want to take just a moment to talk about the 
therapy-driven coloring book consumers. This is a different 
market completely.

The people in this sub-set group rarely buy the books themselves. 

Their counselors and therapists often recommend coloring books to 
address their particular mental health issues. 



Sometimes the counselor or therapist is the buyer of the coloring 
books. 

More often, the person who is buying the book is someone who loves 
the patient. Most likely the patient’s mom, a grandmother, an extended
family member, a teacher, or a good friend.

These buyers are mostly concerned with the mental health of their 
loved ones. 

These buyers often learn about the value of coloring books from 
counselors, therapists, news articles, mental health websites, and other
parents who are dealing with similar issues. 

When writing this type of book description, the feature-benefit is still 
a primary consideration of the buyer, but we would address it 
differently.

In this case, we might actually be better to write our book description 
in third-person, assuming that the person who is making the purchase 
is not intending to use our books themselves.

We could also write our book description speaking directly to the 
patient, but I would expect that to be a much smaller audience than the
persons buying the coloring book for a loved one.

For example…

It is painful to see mom slipping away and losing her ability to 
deal with others. Dementia has taken so many people before 
their time. 

Many mental health professionals have suggested that by simply
presenting new challenges to our loved ones, they can fight back
and recover some of their cognitive abilities in their latter years.



This is why so many geriatric therapists have been 
recommending highly detailed coloring books for people in their
golden years. 

Simply by presenting our parents with fun things to do that 
challenge their minds, many people have successfully been able 
to help their loved ones slow the mental decline, adding more 
joy and happiness to their elder years.

This coloring book has been designed specifically for the 
purpose of challenging the elderly to keep their minds sharp, in 
an effort to slow mental deterioration in older people. 

Those who find joy in the process of coloring the illustrations in 
this book may find a new bounce in their step, as they now have 
an activity to look forward to each day, and they may escape 
depression and have a brighter outlook on life, now that they 
have found something rewarding they can enjoy doing with their
time. 

The fifty illustrations included within this premium coloring 
book may remind your loved ones of happier times, while giving 
them a sense of joy and purpose while coloring the pages within 
this book.

Even though this particular book description targets the therapy-driven
coloring book user, and it focuses the discussion on the loved one who
is making the purchase for someone else, it is directly addressing and 
hinting at the benefit that the end-user (the elderly parent) will receive
as a result of coloring the illustrations in this coloring book.

Instead of heading to Facebook to find colorist groups where people 
go to show off their coloring talents, I would recommend instead to go
find elder-care support groups for adult children and ADHD support 
groups for moms of challenged children.



Once you understand how they talk about the issues they are dealing 
with, you will know how to talk about your coloring book, and you 
will have a better idea where you should go online to recommend your
coloring book to people who might be interested in purchasing it.



Getting the Word Out

There are two times to talk about your book:

1. When you are writing the book description;
2. When you are inviting the world to discover your books.

At both steps, the conversation is pretty similar, but still different.

On your book description, you want to talk about what your book 
includes (features), how people will be impacted by the experience of 
using your book (benefits), and you want to lead the reader to having a
strong desire to click the buy button.

When you are inviting the world to check out your book, you want to 
talk about the same things, but you want to talk about them in a 
different way. 

When they are looking at your book description, your end goal is to 
get them to buy your book. 

When they are looking at you talking about your book somewhere 
else, your end goal is to get them to click a link to take a closer look at
your book.

So, on your “advertisement,” and I use that word loosely, you want to 
create a desire to learn more by talking about how they could benefit 
from buying the book, or even by talking about how others have 
benefited from the book.

For example…

Is your child suffereing from ADHD? I know it can be 
challenging to deal with a child whose brain is always on fast-
forward with no attention to detail, but the worst part is knowing
that your child is missing so much in life and you have no idea 
what you can do to help. 



My child’s second-grade teacher was a godsend. He figured out 
that when my child started bouncing off of walls that he could 
send him to the back of the room and trace a labyrinth with his 
finger, until he calmed down. That was our first breakthrough 
with him.

His teacher then observed that he thought our son had ADHD. I 
was very worried about the diagnosis, because I was worried 
about what those drugs would do to his mind. I shared my 
concerns with my son’s doctor. He assured me that the current 
drugs were a far cry from the Ridlin of yesteryear. Fortunately, 
he was right. We have seen only positive results from the ADHD
drugs that he was prescribed, and we have seen none of the 
negative effects we had seen with other kids long ago.

That labyrinth was brilliant. His teacher figured out that it 
would calm our son quickly. We even purchased our own to keep
at home. It definitely helped the situation. 

To help him calm his mind further, we also introduced him to 
coloring books and we set him up with a 400-pencil set. On 
those rare days now, when he is bouncing off the wall, we send 
him to his room where he promptly brings out his coloring book 
and starts to color. Thirty minutes to an hour is usually all it 
takes to bring his mind to a calm state. 

To be honest, we would have never known that coloring books 
could be used to calm our son, if it had not been for his second-
grade teacher discovering the power of the labyrinth to calm our
son when he had gone into full-blown hyperactive state. 

After realizing how powerful coloring books were in calming my
son, without drugs, I started designing and publishing coloring 
books for other parents to use with their children. 

To learn more about my books, CLICK HERE. 

Nice, eh?



Just by reading that story that I could put into any parenting website, 
you should be able to see how to use the power of storytelling to 
create an interest in owning your coloring books. 

The story is something that should appeal to many parents who have 
children wrestling with ADHD.

There is something I do need to tell you about the story I shared 
above…

It is a true story… It is a true story about my 11yo son…

What makes that story so powerful is that it is authentic and 
believable, and more to the point, the parents who are currently going 
through the same experiences can see in my story a possible solution 
to their problems. 

A possible solution to their problems…

Most people are willing to spend any amount of money, so long as 
there is a promise that you can help them solve a problem they want to
remedy.

Forums and Facebook groups are places you can go to share your 
experiences with people in a similar situation as yourself. 

Articles written for publication on websites is also a viable option for 
growing your audience. 

HINT:  Johanna Basford created the first coloring book to go  
mainstream. “Secret Garden: An Inky Treasure Hunt and Coloring 
Book” has so far been translated into 14 languages. By August of 
2015, it had sold over two million copies worldwide. 

This book went viral, because her publisher started publishing 
“informational articles” that referenced Basford’s book inside the 
article.



Stories that referenced “Secret Garden” started finding publication in 
mid-sized magazines. Eventually, more and more publishers started 
telling the story of the first mainstream coloring book for adults. 

Every year, Basford’s book just got more and more press. In 2015, 
less than two years after its initial publication in 2013, it had been 
mentioned in the following publications:

 The Star (Malaysia)
 The New York Times
 The Daily Mail (UK)
 International Business Times
 The Huffington Post
 The Telegraph (UK)
 And many others...

It has since earned its own Wikipedia page here. 

It wasn’t the illustrations in the book that sold the book. 

It was all of the press it was getting, when people were talking about 
the joy of coloring the illustrations in the book, and the story of how it
became an international best-selling book.

Before ending, I want to say one final thing on this topic. 

Your book is not the story. 

The story is how your book impacts the lives of the people who color 
the illustrations in your book. The story is people’s experience of 
having your book and coloring its illustrations. 

If you want your coloring book to sell loads of copies, focus on your 
book’s story. Focus on how your book can help other people. Focus 
on the experience of the people who color the pages in your book.

And share that story in places where the people, who might like to 
own your book, spend their time online.

https://en.wikipedia.org/wiki/Secret_Garden:_An_Inky_Treasure_Hunt_and_Colouring_Book


Final Words

Creating coloring books is not only fun, but it can also be extremely 
profitable when done right.

Bill and I created this course so you can easily get started creating 
awesome coloring books that you can create in less than an hour.

If you would like to watch over Andreas’ shoulder, as he shows you 
the image editing processes he described inside this guide, check out 
our “Coloring Book Bonanza Advanced” offer...

If you want to dive deeper into the world of coloring books and learn 
how to create amazing mandala coloring books in a matter of minutes,
please check out the special offer called “Low Content Cash Cows,” 
where Andreas teaches how to create awesome mandalas using free 
software and how to create other low-content books quickly.

Also, if you haven’t done so already, take a look at the “Coloring 
Books for Adults Advanced Video Training,” produced by Bill Platt 
in 2015. This package includes 21 videos with a total running time of 
6 hours 19 minutes. These videos cover a lot of additional materials 
related to publishing coloring books.

If you would like some place to go to ask additional questions and 
watch additional training videos produced by Bill Platt, be sure to join
his free Facebook group for coloring book authors:
https://www.facebook.com/groups/ColoringBooksAdults/

To your publishing success

Bill & Andreas

http://coloringbookprofits.com/bonanza/cash-cows.php
http://coloringbookprofits.com/bonanza/index.php
https://www.facebook.com/groups/ColoringBooksAdults/
http://coloringbookprofits.com/bonanza/cbfa-video.php
http://coloringbookprofits.com/bonanza/cbfa-video.php

